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1
	Introduction to 

Bellwether Garden Supply


SOFTWARE OBJECTIVES:  In Chapter 1, you will use the software to:

1.
Start Peachtree Complete Accounting 2003 (PCA).

2.
Explore the sample company, Bellwether Garden Supply.

3.
Back up and Restore Bellwether Garden Supply. 
4.
Operate Peachtree’s drop-down lists, lookup fields, status bar, and navigation aid.

5.
Navigate Windows Explorer.

6.
Explore Peachtree Today to link to the Internet and learn about software features.

7.
Make three backups:  1) one blank, formatted disk to back up starting data for Bellwether Garden Supply; 2) one blank, formatted disk for the Chapter 1 backup; 3) one blank formatted disk for the Exercise 

1-2 backup.
 

WEB OBJECTIVES:  In Chapter 1, you will do these Internet XE "Internet"  activities:

1. Use PCA to link to Peachtree’s website at http://www.peachtree.com.
2. Link to Peachtree Software’s newsroom page. 

3. Select two product news articles, and write an essay about each press release. 

4. Use your Internet XE "Internet"  browser to go to the book’s website at http://www.mhhe.com/business/accounting/yacht2003.

5. Complete the first web exercise in Part 1.

Peachtree Complete Accounting 2003 (PCA) is similar to other programs that use Microsoft Windows.  If you have used other Microsoft Windows programs, you will see the similarities with the menus and windows, entering and saving data, and selecting icons and commands.  If you are not familiar with Microsoft Windows, using PCA will help you become familiar with the Windows operating system.

MOUSE AND KEYBOARD BASICS XE "MOUSE AND KEYBOARD BASICS" 
One of the first decisions you need to make is whether you want to use your mouse or keyboard.  The instructions in this book assume that you are using your mouse.  When the word "click" is used in the instructions, it means to use your mouse, but you can also use the keyboard.  The instructions below explain how to use your mouse or keyboard.

Using the Mouse XE "Using the Mouse" 
· To single click:  position the mouse cursor over what you want to select and click the left mouse button once.
· To double-click:  position the mouse cursor over your selection and click the left mouse button twice, quickly.
· Use the right mouse button the same way you use the left mouse button.
Using the Keyboard XE "Using the Keyboard" 
· If there is an underlined letter in the menu or option you want to select, hold down the <Alt>
 key and the underlined letter to make the selection.
· If you have already held down the <Alt> key and the underlined letter and more selections appear with underlined letters, just type the underlined letter to select the item.

Using Shortcut Keys XE "Using Shortcut Keys" 
Shortcut keys XE "Shortcut keys"  enable you to perform common operations by using two or more keys together.   The tables on the next page show the shortcut keys.

	<Ctrl> + <Letter> Shortcuts

	<Ctrl> + <X>
	Cut

	<Ctrl> + <C>
	Copy

	<Ctrl> + <V>
	Paste

	<Ctrl> + <E>
	Erase

	<Ctrl> + <N>
	New Company

	<Ctrl> + <O>
	Open Company

	<Ctrl> + <B>
	Back Up Company

	<Ctrl> + <R>
	Restore Company

	<Ctrl> + <P>
	Print purchase orders, quotes, invoices, payments or reports

	<Ctrl> + <F>
	Find 

	<Ctrl> + <D>
	Find Next


	Function Key Shortcuts

	<F1>
	Displays the online Help

	<Ctrl> + <F4>
	Closes the current window

	<Alt> + <F4>
	Closes the application window

	<Ctrl> + <F6>
	Moves to the next window

	<Shift> + <Ctrl> + <F6>
	Moves to the previous window

	<F10>
	Toggles the menu bar

	<F5>
	Saves the current record in maintenance windows


PCA'S STARTUP SCREEN

Peachtree's startup screen gives you a number of options. 
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From the startup screen, you can Open an existing company, Set up a new company, Learn about Peachtree Accounting through an online tutorial, Explore a sample company, Convert a QuickBooks® company to Peachtree Accounting, or Close this window.
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Notice that there is an "X" in a box ([image: image1.bmp]) on the upper right-hand side of the smaller "Peachtree Accounting" window.
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If you click on the [image: image2.bmp] on the “Peachtree Accounting” title bar with your left mouse button, the window closes and your screen displays the File, Options, Help menu bar 
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	Comment
The screen illustrations in this text were done with Windows XP and Peachtree Complete Accounting 2003, Educational Version.


THE WINDOWS ENVIRONMENT XE "THE WINDOWS ENVIRONMENT" 
One of the benefits of Windows is that it standardizes terms and operations used in software programs.  Once you learn how to move around in PCA’s menus, you will also know how to use other Windows applications.  

To learn more about the Windows environment, let's look at a PCA screen.  The screen illustration on the next page shows the parts of a PCA window as well as the menu bar for Bellwether Garden Supply.  In Windows 98 and lower operating system versions, notice that each word on the menu bar has an underlined letter. (If you are using Windows XP, menu bar selections do not show underlined letters.)  If your menu bar selections have underlined letters, that means you can make a selection by typing <Alt> and the underlined letter or by clicking on your selection with the mouse.  Each time you make a menu bar selection, a pull-down menu appears. 
For now, let's study the parts of the window shown below.  Some features are common to all software programs that are written for Windows. For example, in the upper right corner is the Minimize 

[image: image3.bmp] button, Double Window [image: image4.bmp] button, and the Close [image: image5.bmp] button.  The title bar, window border, and mouse pointer are also common to Windows programs.  Other features are specific to PCA:  menu bar, status bar, and navigation aid.
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Windows programs all use menus in the form of horizontal menu bars and pull-down menus.  The contents of these menus will differ depending on the application you are using.  PCA's menu bar and pull-down menus are specific to the features needed for general ledger accounting.

(
Peach icon:  Click on the Peach icon and a pull-down menu appears with options such as:  Move, Size, Minimize, Maximize, Close, Next. 

· Title Bar XE "Title Bar"   The bar at the top of your screen.  When a company is open in PCA, the name of the company is displayed on the Title Bar.  If your window is minimized, you can put your mouse on the Title Bar, click and hold the left mouse button and drag the window around the desktop XE "desktop" . The title bar shows “Peachtree Accounting: Bellwether Garden Supply.”
(
Menu Bar:  Notice that each word on the illustrated menu bar  "menu bar"  has an underlined letter. (If you are using Windows XP, the menu bar selections are not underlined.)  If your menu bar selections have underlined letters, that means you can make a selection by typing <Alt> and the underlined letter. For example, in Windows XP if you press the <Alt> key then press the <F> key, the menu bar shows underlined letters as well as the pull-down menu. You can also click with your left-mouse button on the menu bar headings to see a submenu of options. 

(
Minimize [image: image6.bmp], Double Window [image: image7.bmp], or Maximize [image: image8.bmp], and Close or Exit [image: image9.bmp] buttons:  Clicking once on "Minimize" [image: image10.bmp] reduces the window to a button on the taskbar XE "taskbar" .  In Windows, the [image: image11.png]44 start ]



 button and taskbar are located at the bottom of your screen.  Clicking once on Double Window [image: image12.bmp] returns the window to its previous size.  This button appears when you maximize the window.  After clicking on the "Double Window"[image: image13.bmp] button, the symbol changes to the "Maximize" [image: image14.bmp] button.  Click once on the "Maximize" [image: image15.bmp] button to enlarge the window.  Click once on the "Exit" or "Close" [image: image16.bmp] button to close the window, or exit the program.

(
Navigation Aid
:  Peachtree offers a graphical alternative to the menu bar.  The major functions of the program are represented as icons or pictures that show you how tasks flow through the system.  You can click on an icon and perform that function.

(
Status Bar XE "Status Bar" :  The gray bar
 at the bottom of the window shows help information about the current field, today’s date or system date, and the current accounting period.  You can hide the status bar by unchecking the View Status Bar option on the Options pull-down XE "Options pull-down"  menu. 
TYPICAL WINDOWS USED IN PCA

When you make a menu bar selection, a window displays. You can enter information into that window by using your mouse to click on icons or by typing on your keyboard.
The screen illustration below is the "Maintain Customers/Prospects" window, one that is typical of PCA.  There are four sections on this window:  ( the icon bar, ( the lookup fields ("magnifying-glass" icon), 
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 the folder tabs, and ( the drop-down lists (down arrow).
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(
Icon bar XE "Icon bar" 
:  The icon bar shows pictures of commands or additional information that pertains to the window.  Some icons are common to all windows while other icons are specific to a particular window.  The icons included in the "Maintain Customers/Prospects" window are:
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Close:  This closes the window without saving any work that has been typed since the last time you saved.
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Save:  This saves record information you have entered such as addresses, telephone numbers, contacts for vendors, customers, employees, etc.
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Delete:  If you select this while using a selection from the Maintain menu, the record (customer, vendor, etc.) you're working with will be deleted.  When you're finished deleting, select "Close," in order to delete the records.
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Change ID: When a customer record is displayed on the screen, you may change the information for that customer.
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New: If you select this while using a selection from the Maintain menu, this will clear the record that is displayed and allow you to enter a new one.  This can be used with the following Maintain pull-down 

 XE "Maintain pull-down"  menu items:  Customers/Prospects, Vendors, Employees/Sales Reps, Chart of Accounts, Inventory Items, and Jobs.
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Event:  This allows you to schedule an event for a Customer/Prospect. You can choose to have events display or not display in Action Items. Events that you schedule will appear on the Events Tab of Action Items for the date scheduled.  You can use this to log notes about telephone calls, meetings, letters, or any other type of activity.  Use Action Items to show a list of the day's priorities or to create a list of future activities.
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Log:  This shows you events recorded for an individual over a range of time that you specify.  You can filter this list to see only certain types of activities and whether they're completed or not.  You can mark activities as completed by placing a mark in the far left column.  Double-clicking on any of the line items XE "line items"  will take you to the "Create an Event" window.  Line items appear on many of Peachtree's windows.  On color monitors, a magenta line is placed around the row (line item) you select.
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 Help:  This icon is displayed on most windows.  Selecting this icon gives you information specific to the current window.  The fields of the window are often listed at the bottom of the help message.  When you have a question about how to use Peachtree, clicking on the "Help" icon often answers it.

(
Lookup Field XE "Lookup Box" :  The most common field you will type in is called the “text” field.  Sometimes the program will tell you if you type incorrect information, but often you can type whatever you want.

A “magnifying-glass” icon indicates lookup fields.  When you are in the text field portion of the lookup field, the cursor changes to an 

I-bar with a plus sign and question mark <I +?>.  (For example, when you move the cursor to the “Vendor ID” field on the Tasks/Payments window, the <I +?> appears.)  In a lookup field, you can either select from a list of records, such as vendors, customers, accounts, etc. or you can type a new record.  You use one of the methods shown below to display a list or type a new record:

	To display a list
	To enter a new record

	In the text field, click on the "magnifying-glass" icon.
	In the text field, type a <+>.

	In the text field, type a <?>.
	Double-click in the text field.

	In the text field, click the right mouse button.
	Click on the "magnifying-glass" icon, and then select "New."


(
Folder Tabs XE "Folder Tabs" :  The folder tabs that are shown in the "Maintain Customers/Prospects" window are General, Sales Defaults, Payment Defaults, Custom Fields, and History.  Once a customer is selected, you can select one of these folders to display information about a customer.

· Drop-Down List XE "Drop-Down List" :  The down arrow means that this field contains a list of information from which you can make a selection.  Many of PCA's windows have drop-down lists that appear when you click on a down arrow next to a field.  You can press <Enter> or click on an item to select it from the list.

THE SAMPLE COMPANY:  BELLWETHER GARDEN SUPPLY XE "THE SAMPLE COMPANY:  BELLWETHER GARDEN SUPPLY" 
Bellwether Garden Supply is one of the sample companies included with PCA.  You get a sampling of features that are developed in greater detail as you complete this book.  The purpose of using the sample company is to help you become familiar with the software.
GETTING STARTED XE "GETTING STARTED" 
Follow these steps to start Peachtree Complete Accounting 2003 (PCA):

1.
Start Windows.  If Peachtree Complete Accounting 2003 is not installed on your computer, refer to Appendix A for installing the Peachtree Complete Accounting CD that is included with this textbook. 

2.
When Peachtree Complete Accounting 2003 (PCA) was installed, an icon was created for Peachtree.  Place the mouse pointer on the Peachtree icon and double-click with the left mouse button to start PCA.   (Or, click on Start, All Programs, Peachtree Complete Accounting Educational Release.  Then, select Peachtree Complete Accounting.)
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3.
The "Peachtree Accounting" screen appears.  From the startup screen, you can Open an existing company; Set up a new company; Learn about Peachtree Accounting through an online tutorial; Explore a sample company; Convert a QuickBooks® company to Peachtree Accounting; Close this window.

4.
Click on “Explore a sample company” (or hold down the <Alt> key and press <X>).  
	Troubleshooting XE "Troubleshooting" :  What if the startup screen does not appear?  That means someone has turned off this option.  Follow these instructions to open the sample company if the startup screen did not display.

1.
At the Peachtree Accounting menu bar, click on File. The file menu drops down. 

2.
Click on Open Company. The "Open Company" window displays.

3.
In the "Company Name" field, double click on Bellwether Garden Supply. The menu bar for Bellwether Garden Supply appears.   The sample company is started.


5. The "Explore a Sample Company” screen appears.
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6. PCA 2003, has two sample companies:  Bellwether Garden Supply and Pavilion Design Group.  In Chapters 1 – 7, you will use Bellwether Garden Supply to explore Peachtree.  Then, in Chapter 8, you will use Pavilion Design Group to see how Peachtree’s time and billing feature works.  Make sure that Bellwether Garden Supply is selected.  Click on [image: image19.png]


.
7. The “Peachtree Today - Welcome” screen appears.  Read the information on this screen, then click on the “X” ([image: image20.bmp]) on the [image: image95.jpg]


Peachtree Today title bar to close this window.

[image: image96.jpg]Edt Maintain Tasks Analysis

pen Company. cuto
New Company. cuin
prin. ci+p
Print Previen i
Page Setup.
Back L. ci+s
Restare. iR

Select Import/Export,
Data Verfication,
Payroll Tax Tables »

Ext




DISPLAYING PRODUCT INFORMATION XE "DISPLAYING PRODUCT INFORMATION" 
1.
After closing the “Peachtree Today” window, the menu bar for Bellwether Garden Supply appears.  From the menu bar, click on Help, then About Peachtree Accounting.
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This screen shows the copyright information and the Release, Build No., Serial No., Installed Tax Service, and Registered Tax Service. The Release of the educational version is Peachtree Complete® Accounting 2003; the Build No. is 10.0.00.028E, and the Serial No. is Educational Version. If you are using the commercial version of Peachtree, your Release, Build No., and Series No. will differ. The Installed Tax Service and Registered Tax Service could also differ.
To see if software or text updates have been made, periodically check the "Textbook Updates" link on the book's website at www.mhhe.com/business/accounting/yacht2003.
2. Click on [image: image22.png]


 to close the Product Information window. You are returned to the menu bar. 
BACKING UP BELLWETHER GARDEN SUPPLY XE "BACKING UP BELLWETHER GARDEN SUPPLY" 
Before you begin to make changes to Bellwether Garden Supply, you should back up the sample company data.  When using PCA, information is automatically saved to the hard drive of the computer.  In a classroom setting, a number of students may be using the same computer.  This means that when you return to the computer lab or classroom, your data will be gone.  Backing up your data simply means saving it to a floppy disk (or other media), so that it will be available when you want to work again.

	Comment
The author suggests using a blank, formatted disk to make the first back up of Bellwether Garden Supply data.  PCA compresses the backup file, which makes the data smaller.  

You should have at least two chapters of data backed up before reformatting a disk used in an earlier chapter.  For example, you may reformat the disk used to back up Chapter 1 (disk 2 of 18) when you are ready to back up Chapter 3.  Refer to the chart on page 2 for backup information.

When you back up, you are saving to the current point in Peachtree.  Each time you make a backup, you should type a different backup name (file name) to distinguish between them.  In this way, if you need to restore an earlier backup, you have the data for that purpose.

In the business world, backups are unique to each business:  daily, weekly, monthly.  Think of your backups this way and you will see why individual backups for different points in the data are necessary.  You should never leave the computer lab without first backing up your data.


Follow these steps to back up Bellwether Garden Supply:

1. Put a blank, formatted disk in drive A or B.  The text directions that follow assume you are using a blank, formatted disk in drive A for backing up Bellwether Garden Supply. If you have a CD-RW disk drive or Zip disk drive, you can use one CD-R or Zip disk for all the backups in the textbook (Chapters 1 through 18). 
2.
From the menu bar, click on File, then select Back up. The "Back Up Company" window appears.  If necessary, uncheck the box next to “Include company name in the backup file name.” 
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3.  Click on the [image: image23.jpg]Back Up Now



  button.

4. 
Click on the down-arrow in the "Save in" field. The list that displays shows you the location on your hard drive for the sample company files. 
[image: image98.jpg]



5.
Since you are going to back up to drive A, if necessary, scroll up the list, then click "3½ Floppy (A:)" to select drive A.
  Observe that the “File name” field shows the default XE "default"  name. In the “File name” field, highlight the default XE "default"  file name, then type bgs as the file name.
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Observe that the "Save as type" field shows that you are making a Peachtree Backup (*.ptb), which is abbreviated ptb.  This is the standard default XE "default"  for Peachtree backups.

	Comment
If your “Save as type” field does not show “Peachtree Backup (*.ptb), follow these steps:

1. 
Click on the [image: image24.png]44 start ]



 button, then All Programs. Select Accessories, then Windows Explorer. (These instructions are for Windows XP.)
2. 
From the menu bar, click on View, then Choose Details.
3. 
Make sure the box next to “Type” is checked. If necessary, click on the box to check it.

4. 
Click on [image: image25.png]


.  Your PCA files will now have file extensions.
5.    Click on File, Close to close your Windows Explorer screen. 




6.
Click on the [image: image26.jpg]


 button.
7.
A screen pops up that says “This company backup will require approximately 1 diskette.”
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8. Click on [image: image27.png]


.  Another screen pops up that says "Please insert the first disk. . . ."
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9. Click on [image: image28.png]


. When the "Back Up Company" scale is 100% completed, you have successfully backed up the sample company.  This takes a few moments. Your screen is returned to Bellwether's menu bar.

Follow these steps to see the size of the backup file.

1. Click on the [image: image29.png]44 start ]



 button.  Then select All Programs.  From the drop-down list, select “Accessories”, then "Windows Explorer." (Hint: These instructions are for Windows XP; they may differ slightly for other Windows versions.)
2. In the “Address” field, click on the down-arrow, then select select drive A (3½ Floppy (A:). If necessary, select View, Details to see the screen illustration below.  
[image: image102.jpg]Changeld




The “Name” of the file is bgs.ptb; the “Size” of the file is 851 KB;
 the "Type" is PTB File; and "Modified" shows the date and time of the back up.  Compare this information to the bcs folder on your hard drive (C:\Peachw\Bcs), which is 6.40 MB (megabytes).  Since the Peachtree backup file is 851 KB, and a disk holds 1.44 MB of data, you will be able to save one Bellwether backup file on one blank, formatted disk.  

Refer to the chart on page 2 for disk, back up, and kilobyte information.  Since Peachtree backs up to the current point, you should periodically reformat disks. (Hint: Remember to have at least two chapters backed up before you reformat.)

If you do not want to reformat disks, you will need 14 blank, formatted disks to back up Chapters 1 – 8.  Remember to refer to the chart on page 2 to see how many disks you will need for backing up Part 1 of the book.  You can also reformat disks used in earlier chapters.

Follow these steps to exit Peachtree:

1. 
From the menu bar, click on File, Exit.

2. 
You are returned to your Windows desktop XE "desktop" .

USING WINDOWS EXPLORER XE "USING WINDOWS EXPLORER" 
The instructions on pages 15 - 19 show you how to use Peachtree’s Back Up feature. You learned that when you back up the company file to 

drive A, the information is compressed or made smaller.  Peachtree’s Back Up feature works with their Restore feature, which is shown on pages 22 - 24.  What if your instructor prefers that all of the company files be copied or saved? 
1. 
Your Windows desktop XE "desktop"  should be displayed on your screen. 

2. 
If your desktop XE "desktop"  has a "Windows Explorer" icon double-click on it. Or, click on the [image: image30.png]44 start ]



  button; select “All Programs," then “Accessories; then "Windows Explorer." 
3. 
In the “Address” field, select drive C. Then, open the folder for Bellwether Garden Supply: C:\Peachw\Bcs.
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4. 
Right-click on the "Bcs" folder.  A drop-down menu appears.  Left-click on Properties.
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5. 
Observe that the size of the "Bcs" folder is 6,720,492 bytes (or 6.40 MB) used. That means this file is too large for one blank formatted disk, which holds 1,440,000 bytes. If you want to copy the entire folder to a disk, you will need to have a Zip drive or CD-RW drive. The steps in the “Copying the Bcs folder to a Zip Drive or CD-RW Drive” show you how to do that. Peachtree folders need read and write access in order to be used.  Floppy disk drives, Zip disk drives and CD-RW disk drives are read/write.

6. 
Click on [image: image31.png]


 to close the "Bcs Properties" window. Click on the [image: image32.bmp] on the C:\Peachw\Bcs title bar to close Windows Explorer.
Copying the Bcs Folder to a Zip Drive or CD-RW Drive 
The steps that follow show you how to copy the "Bcs" folder to a Zip disk in drive E, or to CD-RW drive F. If your Zip drive or CD-RW drive is located in a different location, substitute that drive letter. Depending on what software you are using to copy CDs, your instructions may differ.
1. From the menu bar, click on File, Exit to exit Peachtree and return to your desktop. Put a Zip disk in drive E, or a CD-R disk in your CD-RW drive.  In this example, drive E is used for the Zip drive and drive F to identify the CD-RW drive. (Substitute your correct drive letter.) 

If you are copying files to a CD, a window may pop-up that asks “What do you want Windows to do?” In this example, the “Open writable CD folder using Windows Explorer” was selected.
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Locate the "Bcs" folder on your hard drive. The default XE "default"  location is C:\Peachw\Bcs.  Click on “Bcs” to select it. On the left side of your screen, there is a “File and Folder Tasks” list. Click on Copy this folder.  

[image: image106.jpg]Help
Cascade

Tie
Arrange Icons
Close Al

+ 1Peschiree Today - Welcome




3.
When the “Copy Items” window pops up, select the appropriate Zip drive or CD-RW drive to copy to. In this example “CD Drive (F:)” is shown. You should select the correct drive on your computer for either your Zip drive or CD-RW drive. 
[image: image107.jpg]
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4.
Click on [image: image33.png]


.  A screen pops up showing the files are being copied.  If you are copying the files to a CD, make the selections to write the files to your CD.

5. To check that the file was copied, make sure your CD disk or Zip disk is in the drive, then go to the appropriate drive right-click on the “Bcs” folder and select Properties. The “Bcs Properties” window should look the same as the one shown on page 20, under step 4.
6. Click on the [image: image34.bmp] on the title bar to close the windows.


When you copy the “Bcs” folder from drive C to a Zip disk or CD, you are copying all the files contained in the folder. Remember, backing up files compresses the data (or makes the file smaller). Copying the entire folder allows you to have all the Bcs files on external media.  When you want to return to where you left off, you can use Windows Explorer to copy and paste these files from your Zip or CD-RW disk to Peachtree’s program path and Bellwether’s folder (subdirectory) on drive C – C:\Peachw\Bcs.  Remember, the instructions in the textbook teach you how to use Peachtree’s Back Up and Restore features.  Check with your instructor for his or her preference.

RESTORING COMPANY DATA FROM A FLOPPY DISK XE "RESTORING COMPANY DATA FROM A FLOPPY DISK" 
In order to start where you left off the last time you backed up, you use the Restore command.  Your school may prefer that you use the Windows Explorer copy and paste command instead of Peachtree’s Restore feature.  You may need to check with your instructor on the preferred method.  This book uses Peachtree’s Restore feature.

Follow these steps to use Peachtree’s Restore feature.
1.
Start Windows and Peachtree in the usual way. 

2.
On the startup screen, click on Explore a sample company.  Make sure Bellwether Garden Supply is selected. Click on [image: image35.png]


.

3.
To restore Bellwether’s files, do the following:


a.
Put your backup disk in drive A.


b.
From the menu bar, click on File, then Restore.  The "Open Backup File:" window appears.

c.
The "Look in" field shows the hard drive location of the sample company’s files.  Click on the down-arrow in the "Look in" field. Then click on "3½ Floppy (A)" to select drive A. Compare your screen to the one shown below.
[image: image110.jpg]



d.
Click on the "bgs.ptb" file to highlight it.

[image: image111.jpg]





Observe that the "File name" field displays bgs. The “Files of type” field shows “Peachtree Backup (*.ptb).  If your “Files of type” field does not show Peachtree Backup, see the "Comment" box on page 17.  


e.
Click on the [image: image36.png]


  button.

f. 
A "Warning!" screen pops up.  Read the information on this screen.
g. Click on [image: image37.png]


.  The “Restore Options” window pops up.  


h. Make sure that the check mark is next to Company Data.  Click on [image: image38.png]


.

i. The "Restore Company" window pops up.  When the scale is 100% completed, the sample company data is restored.  On “Peachtree Today’s” title bar, click on the [image: image39.bmp] to close the “Peachtree Today” window.

j. Remove the backup disk from drive A.

Now that you have restored Bellwether’s files, you are ready to continue using the sample company.  Remember before you exit PCA, make a backup of your work.  
USING PEACHTREE TODAY XE "USING PEACHTREE TODAY" 
The instructions that follow assume PCA was just installed and is being used for the first time.  If PCA has been used before, your "Peachtree Today" window may look different. 

At the bottom of your screen on the status bar, there is a [image: image40.jpg]i Today]



 icon. If necessary, click on the [image: image41.jpg]i Today]



  icon, and the “Peachtree Today” window pops up. If your Peachtree Today window is already displayed on your screen, continue with the next section.
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The Peachtree Today window is shown below.
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Your screen may differ.  This is okay.  Read the information on this screen to become familiar with what it says.  You may want to explore some of the links.  The underlined words are links to other information.

Follow these steps to try one of the links.

1. Move your cursor over My Business. Observe that your cursor changes to a hand. (If you do not have a My Business link, go to 


step 2.)

2. Click once on the My Business link. (If PCA has been used before, click on the "My Business" radio button on the left side of "Peachtree Today's window).  The “Peachtree Today” window appears.

3. If necessary, scroll down the screen to see more. You can also explore additional links by clicking on another tab.
4. When you are through, click on the [image: image44.bmp] on Peachtree Today - "My Business Sales & Receipts" title bar.  
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5. You are returned to Bellwether Garden Supply's menu bar.
To hide the "Peachtree Today" window at startup, follow these steps.

1. On the status bar, click on the [image: image46.jpg]i Today]



 icon.  The "Peachtree Today – Welcome " window appears.

2. Click on the [image: image47.jpg]iy Preferpnces
G Pascres Tk



 link.

3. If necessary, scroll down the screen to go to the “Start Up” area. Observe that there is a check mark next to "Display Peachtree Today each time this company is opened." Click on the box to uncheck it.
4. Click on the [image: image48.bmp] on the "Peachtree Today – Preferences General" title bar.

To check that Peachtree Today no longer displays at startup, follow these steps.
1. From Bellwether’s menu bar, click on File, Exit.  You are returned to your Windows desktop.

2. Restart Peachtree. At the startup menu, select “Explore a sample company.” Make sure that the radio button for Bellwether Garden Supply is selected, then click on [image: image49.png]


.
3. When Bellwether starts, the Peachtree Today window is not displayed on your screen. If Peachtree Today is displayed, complete the steps that follow. 
a.
Link to Preferences.
b.
Scroll down the screen to the "Start Up" section.
c.
Make sure the box is unchecked next to "Display Peachtree Today each time this company is opened."  Close the Peachtree Today window.
MENU BAR XE "MENU BAR"  
PCA's menu bar has ten pull-down menus:  File, Edit, Maintain, Tasks, Analysis, Options, Reports, Services (this selection is active on the commercial version and inactive on the educational version), Window, and Help.  

Follow these steps to explore the menu bar.

1.
From the menu bar, click on File to see its pull-down menu, or if you prefer, press <Alt> + F to display the File pull-down menu. XE "File pull-down menu"   If you use <Alt> + F instead of your mouse, notice that the individual letters on the menu bar are underlined. In this example, the mouse was used.


In order to show these File pull-down menu XE "File pull-down menu"  selections, the General Ledger Trial Balance was displayed from the Reports pull-down menu XE "Reports pull-down menu" .


The File pull-down menu XE "File pull-down menu"  allows you to open an existing company, create a new company, print, print preview, setup the page, back up and restore data, make an online backup (if you subscribe to this service), import files into PCA from other programs, export files from PCA to other programs, verify data, load and edit payroll tax tables, and exit.  
Pull-down menu choices that are followed by an ellipsis are associated with dialog boxes XE "dialog boxes"  or screens that supply information about the window you are using.  An arrow (►) next to a menu item (Payroll Tax Tables) indicates that there is another pull-down menu or submenu with additional selections. 


To cancel the pull-down menu, click on File or <Esc>.

2. Click on Edit to see its pull-down menu.


In order to show these Edit selections, the "Maintain Customers/ Prospects" window was opened.  Then, one of the customer records was selected. The grayed-out selections are inactive.
The Edit pull-down menu XE "Edit pull-down menu"  allows you to cut, copy, paste, and clear objects from one place to another via the Windows feature called the clipboard.  Change ID allows you to change information in maintenance windows.  You can also Find Transactions.  You can also Send E-mail and view web pages.  You can also filter records, locate fields, change fonts, and show headers.  Delete Record allows you to delete maintenance records.

3.
Click on Maintain to see its pull-down menu.



The Maintain pull-down XE "Maintain pull-down"  menu allows you to enter, view, or edit required information for your company's customers or prospects, vendors, employees or sales reps, chart of accounts, inventory items,  and job costs. You can also edit company information, use the setup checklist, enter memorized transactions, default XE "default"  information, sales tax codes, and passwords.  Defaults are commands that PCA automatically selects.  Default information automatically displays in windows.  You can change the default by choosing another command. 

4.  Click on Tasks to see its pull-down menu.


The Tasks pull-down XE "Tasks pull-down"  menu allows you to enter quotes and sales orders, sales invoices, receipts, finance charges, select for deposit, issue credit memos, purchase orders, purchases for inventory, select bills to pay, make payments, write checks, issue vendor credit memos, record time and expenses, record payroll information, and make general journal entries. You can also make inventory adjustments, assemblies, reconcile bank statements, void checks, and enter action items.  With the System selection, another pull-down menu displays with choices such as post and unpost (available with batch posting), change the accounting period, use the year-end wizard, and purge old or inactive transactions.

5.
Click on Analysis to see its pull-down menu.


The Analysis pull-down XE "Analysis pull-down"  menu allows you to view customized graphics developed for specific companies.  You can use the cash manager, collection manager, payment manager and financial manager.

6.
Click on Options to see its pull-down menu.


The Options pull-down XE "Options pull-down"  menu allows you to set global options XE "global options"  for a company, change the system date and define your Internet XE "Internet"  connection.  Global options are settings that affect the entire program.  When you set global options for one company, you set them for all companies.  

The check marks next to View Status Bar XE "Status Bar" , View Navigation Aid, and View Startup Screen sets these options on your Peachtree screen.  If they are unchecked these options will not display.

7. Click on Reports to see its pull-down menu.



The Reports pull-down menu XE "Reports pull-down menu"  allows you to queue XE "queue"  reports for printing or display reports on your screen.  You can also create and edit the format for reports, forms, and financial statements.  The My Business selection takes you to “Peachtree Today – My Business Sales & Receipts” window. This screen was shown on page 25. The Crystal Report Designer allows you to access, analyze, report and share data.  

8.
The Services pull-down menu is inactive in the educational version of PCA.  On the commercial version of Peachtree Complete 2003, the Services pull-down menu has selections for Peachtree Today, Check for Updates, Credit Card Authorization, Internet XE "Internet"  Postage, My Web Site, Peachtree Web Services, Peachtree Web Transaction Center, and the PeachSync Wizard. 

9.
Click on Window to see its pull-down menu.  (Hint: To see these choices, click on [image: image50.jpg]i Today]



 on the status bar.  The "Maintain/Customers Prospects" and general ledger report windows were closed.)


The Window pull-down XE "Window pull-down"  menu allows you to arrange how the windows and icons are displayed and close all open windows.  Cascade allows you to display document windows in overlapping format on the screen. Tile allows you to display windows side by side, with no window overlapping any other window.  You can also select Arrange Icons to change the look of your desktop XE "desktop" . Close All allows you to close all the windows or windows at once.  According to the list shown on the Window pull-down menu, there is one window open: 1 Peachtree Today - Welcome.

10.

Click on Help to see its pull-down menu.


The Help pull-down menu XE "Help pull-down menu"  allows you to open a window of context-sensitive help, run tutorials for PCA and Windows, and display file statistics.  Additional Products and Services includes information about Peachtree Software.  Select About Peachtree Complete Accounting to display product information.  How to display product information was shown on page 14.

BECOMING AN EMPLOYEE OF BELLWETHER GARDEN SUPPLY XE "BECOMING AN EMPLOYEE OF BELLWETHER GARDEN SUPPLY" 
Before you add yourself as an employee of Bellwether Garden Supply, let's learn how to use the Navigation Aid to open the "Maintain Employees" window.  The Navigation Aids XE "Navigation Aids"  are listed across the bottom of your screen.  They are:  Sales, Purchases, General Ledger, Payroll, Inventory, Time & Billing, Analysis, and Company.

Follow these steps to use the Navigation Aid to add yourself as an employee.  Close the Peachtree Today window before you begin. 

1.
At the bottom of your screen, click on the Payroll Navigation Aid [image: image51.png]o Payrol



. The “Peachtree Today – Navigation Aids Payroll” window pops up.

The Payroll Navigation Aid flow chart shows what happens when a Payroll Entry is made.  Observe the links on the flow chart. These selections can also be made from the Maintain, Tasks, and Reports pull-down menus. The Payroll Navigation Aid organizes information into three sections.

a.
Maintenance selections include links to “Employees,” “Edit Company Tax Tables,” and the “Payroll Setup Wizard.” 
b.
Task selections include links to “Select for Payroll Entry,”  “Payroll Entry,” “Print Payroll Checks,” and “Void Checks.”
c.
Report selections include links to “All Payroll Reports,” “Payroll Journal,” and “General Ledger.” 
2.
Click on [image: image52.jpg]


  The "Maintain Employees/Sales Reps" window appears.



(  The icon bar at the top of most windows shows graphical representations of commands or functions that are accessible from the window.
(Lookup fields have a text field and a "magnifying-glass" icon.   When you are in the text field portion of the lookup field, the cursor changes to an I-bar and a question mark  < I ? >.  Click the left mouse button on the "magnifying-glass" icon, or type a question mark <?> in the text field, or click the right mouse button to display lists.

(  Radio Button or Option Button XE "Option or Radio Buttons" :  These buttons allow you to select one by clicking with the mouse or using the space bar.  The default XE "default"  is "Employee" shown by the radio button next to "Employee."


(  Folder tabs are common to most PCA windows. They provide a subtitle to the various screens that store and organize information.  Here, for example, the information you can choose to track is subdivided into five sections:  General, Custom Fields, Pay Info, EmployEE Fields, and EmployER Fields.

(  Text fields are rectangles or fields where information is typed.

(  List Box XE "List Box" :  Select the arrow to drop down or open a list from which you can select an option.

(  Date fields; Calendar icons: You can type dates in the text field or click on the calendar icons. The date is selected by clicking within the calendar icon.

Adding Yourself as an Employee XE "Adding Yourself as an Employee" 
Follow these steps to add yourself as an employee.

1.
Type an Employee ID code for yourself in the "Employee ID" field.  For example, type CYACHT-01 (type the first initial of your first name, your full last name, a hyphen, zero, then one); use all capital letters) and press <Enter>.

2.
In the "Name" field, type your first name, press <Enter>; type your middle initial, if any, press <Enter>, then type your last name.  Press <Enter> two times.
 

3.
In the "Address" field, type your street address.  There are two lines so you can enter an ATTENTION line or P.O. Box, if necessary.  If you are using just one line for your address, press <Enter> two times to go to the "City, ST Zip" fields.

4.
In the "City, ST Zip" field, type your city, state (two-digits), and zip code, pressing <Enter> after each.

5.
None of the other information is required.  You will work with the other fields in the Payroll chapter.  Click on the [image: image53.jpg]fit=
18



 icon or press the function key <F5> to save your entries.

To check that your Employee ID has been added, click on the magnifying glass next to the Employee ID text field.

6.
Select "Close" or <Esc> to return to the menu bar. Close the Payroll Navigation window.
BACKING UP CHAPTER 1 DATA XE "BACKING UP CHAPTER 1 DATA" 
Follow these steps to back up Chapter 1 data:

1.
Put a blank, formatted disk in drive A.  

2.
From the menu bar, select File, then Back up.

3. 
Click on the [image: image54.jpg]Back Up Now



 button.

4. 
Click on the down-arrow in the "Save in" field.  If necessary, scroll up the list, then click on "3½ Floppy (A:)" to select drive A.

5. 
Type Chapter 1 in the "File name" field.

6. 
Click on the [image: image55.jpg]


  button.  

7. 
When the screen prompts that "This company backup will require approximately 1 diskette," click on [image: image56.png]


.

8. 
When the screen prompts you to insert the first disk, click on [image: image57.png]


.  When the "Back Up Company" scale is 100% completed, you have successfully backed up to the current point in Chapter 1.  You are returned to the menu bar.

9. 
Click on File, Exit to exit Peachtree.

MANUAL VS. COMPUTERIZED ACCOUNTING XE "MANUAL VS. COMPUTERIZED ACCOUNTING" 
Because there are differences between manual and computerized accounting systems, you will notice in several instances that the procedures used in PCA are slightly different than those outlined in the steps of the manual accounting cycle.  

The differences between the Manual and Computer Accounting Cycle are shown on the next page.  The first step of the Computer Accounting Cycle is New Company Set Up, which includes the option for selecting a Chart of Accounts.  The Manual Accounting Cycle does not include a New Company Set Up.  In manual accounting, the chart of accounts is the same as the accounts in the general ledger.

Step five of the manual cycle shows a worksheet.  There is no worksheet in the computerized cycle.  

In PCA you can complete account reconciliation.  Account reconciliation automates bank reconciliation.  

Another important difference is that in the Computer Accounting Cycle, the adjusting entries are journalized and posted before printing the financial statements.  

In the computerized cycle, Step 10, change accounting periods, is similar to closing the month manually except that the temporary accounts maintain balances so a post-closing trial balance is not available.  PCA tracks income and expense data for an entire year.  At the end of the year, all revenue and expense accounts are closed to equity.  

	MANUAL ACCOUNTING CYCLE
	PCA’s COMPUTER ACCOUNTING CYCLE

	1. 
Analyze transactions


	 1.
New Company Set up.  (You have the option of selecting a chart of accounts.)

	2.
Journalize entries.
	 2.
Analyze transactions.

	3. 
Post to the ledger.
	 3.
Journalize entries.

	4. 
Prepare unadjusted trial balance.
	 4.
Post to the ledger.

	5. 
Prepare worksheet.
	 5.
Print general ledger trial balance (unadjusted).

	6.
Prepare financial statements: income statement, statement of changes in owner's equity, and balance sheet.
	 6.
Account reconciliation: reconciling the bank statement.

	7.
Adjust the ledger accounts: journalize and post adjusting entries.
	7.
Journalize and post adjusting entries.

	8.
Close the temporary accounts:  journalize and post the closing entries.
	 8.
Print the general ledger trial balance (adjusted).

	9.
Prepare post-closing trial balance.
	 9.
Print financial statements:  balance sheet, income statement, statement of cash flow, and statement of changes in financial position.

	10.
Reverse entries (optional).
	10.
Change accounting periods.

	Interpret accounting information.


	INTERNET ACTIVITY XE "INTERNET ACTIVITY" 

	The Internet XE "Internet"  is a worldwide electronic communication network that allows for the sharing of information. The World Wide Web XE "World Wide Web"  (WWW) or Web is a way of accessing information over the Internet. To read about the differences between the Internet and the Web, go to www.webopedia.com/DidYouKnow/Internet/2002/Web_vs_Internet.asp.
To make an Internet connection, your computer must be equipped with a modem XE "modem" . The word modem is an abbreviation of Modulator/Demodulator. A modem is a device that translates the digital signals from your computer into analog signals that can travel over telephone lines. There are also wireless radio modems, cable modems, and T-1 lines for faster connections.

	1.
	Start Windows, then PCA. Open Bellwether Garden Supply. Minimize Peachtree, and then connect to your Internet browser.

	2.
	Maximize Peachtree. Start “Peachtree Today.” (Hint: If necessary, click on the "Today" icon on the status bar.)  Select “My Resources[image: image58.jpg]L] Myﬁmurws



. (Hint: You must be connected to the Internet. XE "Internet"  If a window pops up that asks if you want to make an Internet connection, follow the screen prompts to make a connection. A window may pop up that says “You are about to enter a server-provided Internet Resource.” Click on OK to continue.)

	3.
	If necessary, scroll down the screen to the “Stay in Touch with Peachtree” section. Click on Peachtree.com. [image: image59.jpg]Touch With Peachtree
Helping You To Stay Informed

® Peachgree.com ® Peachtres Services
* Online Support  Online Ordering

® Product Feedback



. 

	4.
	Websites are time and date sensitive.  When using the Internet XE "Internet" , be aware that changes will likely take place.  For purposes of this assignment, you will link to Peachtree’s press releases. When you place your cursor over “News” a drop-down list appears [image: image60.jpg]Success Stories

Awards
Expert Reviews
Reviewsr's Guides b
Contadts



. Select “Press Releases.” Then, link to   [image: image61.jpg]P Product News



. The “Peachtree Newsroom” page appears.

	5.
	Select two links from the list of press releases. Using a word processing program, write an essay about each site you selected. Remember to include the website address of each link. Your summary for each site selected should be no more than 100 words or less than 75 words.

	6.
	From your Internet XE "Internet"  browser, go to the textbook’s website at http://www.mhhe.com/business/accounting/yacht2003.

	7.
	Link to Internet XE "Internet"  Activities, then WEB EXERCISES, PART 1.

	8.
	Complete the first activity, "ACCOUNTING MONOPOLY – Chapter 1." This is a group activity. Check with your instructor regarding this assignment.


SUMMARY AND REVIEW

SOFTWARE OBJECTIVES:  In Chapter 1, you used the software to:

1.
Start Peachtree Complete Accounting 2003 (PCA).

2.
Explore the sample company, Bellwether Garden Supply.

3.
Back up and Restore Bellwether Garden Supply.

4.
Operate Peachtree’s drop-down lists, lookup fields, status bar, and navigation aid.

5.
Navigate Windows Explorer.

6.
Explore Peachtree Today to link to the Internet and learn about software features.

7.
Make three backups:  1) one blank, formatted disk to back up starting data for Bellwether Garden Supply; 2) one blank, formatted disk for the Chapter 1 backup; 3) one blank formatted disk for the Exercise   1-2 backup.

WEB OBJECTIVES:  In Chapter 1, you did these Internet XE "Internet"  activities:

1. Used PCA to link to Peachtree’s website at http://www.peachtree.com.
2. Linked to Peachtree Software’s newsroom page. 
3. Selected two product news articles, and wrote an essay about each press release. 
4. Used your Internet XE "Internet"  browser to go to the book’s website at http://www.mhhe.com/business/accounting/yacht2003.
5. Completed the first web exercise in Part 1.

GOING TO THE NET

	Comment
The textbook website at http://www.mhhe.com/business/accounting/yacht2003 has a link to "Textbook Updates." Check this link for updated Going to the Net exercises.


 XE "GOING TO THE NET" 
Access the Career Development website at

http://www.net-temps.com/careerdev/index.htm?type=careertalk&channel=fin&topic=careers
Read the article "Careers in Accounting & Finance."
1. What three skills are essential for those seeking careers in accounting and finance?

2. What is the preferred educational background for an accountant?

3. List five career opportunities in accounting and finance.

True/Make True:  Write the word True in the space provided if the statement is true.  If the statement is not true, write the correct answer.

1.
If there is an underlined letter in the menu or option you want to select, hold down the <Alt> key and the underlined letter to make the selection.



_______________________________________________________


_______________________________________________________

2.
Shortcut keys XE "Shortcut keys"  enable you to use Peachtree’s mouse.




_______________________________________________________


_______________________________________________________

3.
The menu items that have an arrow next to them indicate that there is another pull-down menu with additional selections. 


_______________________________________________________


_______________________________________________________

4.
In this book, the greater and lesser signs are used to indicate individual keys on the keyboard; for example <Tab>.




_______________________________________________________


_______________________________________________________

5.
You can close the application you are working with if you single click with your mouse on the close button ([image: image62.bmp]).


_______________________________________________________


_______________________________________________________

6.
You can hide the status bar on your screen by unchecking that option on the Options menu.


_______________________________________________________


_______________________________________________________


7.
In PCA, some icons are common to all windows while other icons are specific to a particular window.


_______________________________________________________


_______________________________________________________

8.
The Navigation Aid is shown at the top of your window.


_______________________________________________________


_______________________________________________________


9.
The most common field you will type in is called the drop-down list.


_______________________________________________________


_______________________________________________________

10.
The extension used for Peachtree backups is ".XLS."


______________________________________________________


______________________________________________________

Exercise 1-1:  Follow the instructions below to complete Exercise 1-1:

1. Start Windows, then PCA.  Start the sample company, Bellwether Garden Supply.

2. Follow these steps to restore your data from the end of Chapter 1:

a. Put your Chapter 1 backup disk in drive A.  You made this backup on pages 38-39.

b. From the menu bar, click on File, Restore.  The “Open Backup File:” window appears.

c. Click on the down-arrow in the “Look in” field.  Then click on "3½ Floppy (A:)" to select drive A.

d. Click on the "Chapter 1.ptb" file to highlight it.  The "File name" field displays Chapter 1.
e. Click on the [image: image63.png]


 button.

f. Read the information on the "Warning!" window.  Click on [image: image64.png]


.

g. The “Restore Options” window pops up.  Make sure that the check mark is next to Company Data.  Click on [image: image65.png]


.
h. When the "Restore Company" scale is 100% completed, your data is restored and you are returned to the menu bar.  
i. Remove the backup disk.

3. Continue using PCA and complete Exercise 1-2.

Exercise 1-2:  Follow the instructions below to complete Exercise 1-2:

1.
Add Jackie Scruggs as the new employee.


Employee ID:
JSCRUGGS-01 [use all caps; use a zero]


Name:


Jackie Scruggs

Address:

1300 Aspen Avenue

City, ST Zip:
Atlanta, GA 30319
2. Follow these steps to back up Exercise 1-2:

a. Put a blank, formatted disk in drive A.
b. From the menu bar, select File, then Back up.

c. Click on the [image: image66.jpg]Back Up Now



 button.
d. Click on the down-arrow in the "Save in" field.  If necessary, scroll up the list, then click on "3½ Floppy (A:)" to select drive A.

e. Type Exercise 1-2 in the "File name" field.

f. Click on the [image: image67.jpg]


 button.

g. When the screen prompts that "This company backup will require approximately 1 diskette," click on [image: image68.png]


.
h. When the screen prompts you to insert the first disk, click on [image: image69.png]


.  When the "Back Up Company" scale is 100% completed, you have successfully backed up to the current point in Chapter 1.  You are returned to the menu bar.
3. 
Click on File, Exit to exit Peachtree. 
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	�If Peachtree Complete Accounting 2003 is not installed see Appendix A, “Installing the Software,” pages 671-676. The sample companies must be installed to complete Chapters 1–8.


	


	� Refer to the chart on page 2, for information about backing up data.


	�The greater and lesser signs are used around words to indicate individual keys on your keyboard; for example, <Alt> is for the "Alternate" key, <Enter> for the "Enter/Return" key, <Ctrl> is for the "Control" key, <Esc> is for the "Escape" key.


	�If the Navigation Aid is not displayed on our screen, from the menu bar� XE "menu bar" �, select Options, click on View Navigation Aid to place a check mark next to it.


	�Screen colors may differ.  Check with your instructor if you have a question.


	�Notice that familiar business items are used for icons:  file folder (Close), floppy disk and Rolodex card (Save), and a trash can (Delete).


	�If you are backing up to a CD-RW or Zip drive, substitute the appropriate drive letter. 


	�You may notice that the size of your backup file differs from the amount of kilobytes shown on page 18. This is okay.


	�All ID codes are case-sensitive� XE "case-sensitive" � which means that cyacht-01 and CYACHT-01 are considered different codes. Capital letters sort before lowercase letters.


	�You can use <Enter> or <Tab> to move from field to field.  Use <Shift>+<Enter> or <Shift>+<Tab> to move back a field.  You can also hold the <Alt> key and press the underlined letter of a text box to move between fields.
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